
Course Outline
Day One
 i. Introduction to Flash CS5

a. history, current, future
b. examples

 ii. Get Acquainted (chapter one)
a. new project
b. the interface overview
c. stage properties
d. tools
e. property inspector and library panel 
f . timeline, frames and layers
g. save, preview, and publish a Flash file

 iii. Break
 iv. Graphics (chapter two)

a. drawing tools, strokes and fills
b. creating and editing shapes
c. drawing modes
d. gradient and bitmap fills
e. patterns and the deco tool
f . align, break apart, & group
g. curves
h. transparency
i . text

Day Two
 i. Symbols (chapter three)

a. import artwork
b. Create a symbol and symbol types
c. editing symbols and sizing
d. symbol properties
e. 3D space

Day Three 
 i. Overview of previous classes
 ii. Animation (chapter four)

a. position, scale, rotation 
b. pacing & timing animation
c. animate transparency
d. path of motion
e. symbol animation
f . easing
g. 3D space animation
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http://2009.max.adobe.com/awards/finalists/

Adobe Flash CS5 30 Day Trial
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2003: Flash MX 2004 (version 7)
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1999: Flash 4
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1996: Program sold to Macromedia (renamed Flash)
early 1996: FutureSplash Animator
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Classroom in a Book
ISBN: 0-321-70180-1



Adobe Flash CS5 Introduction 2
Welcome Screen
Create New
ActionScript 3.0

ActionScript: the 
programming language within 
Adobe Flash. ActionScript 3.0 
is the most recent version of 
this language. 

Flash CS5 Interface
1. Stage
2. Tools 
(see textbook p.32)
3. Property Inspector
 & Library 
Panels
4. Timeline & Frames
5. Layers
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1. Stage
The area your audience will see when you export out 
your final project. The Stage size, color and other 
properties like Frames per Second can be set using 
the Property Inspector when the Stage is selected.

2. Tools
Allow you to select, resize, and do a wide variety of 
other manipulations to graphics on the Stage. Use 
tools to draw graphics, type text, select items, and 
fill areas in with color. See page 32 in the text for a 
description of all Tools in the toolbar.

3. Property Inspector & Library Panel
Property Inspector shows you attributes of selected 
items on the Stage or the entire Stage (width, height, 
placement of items, etc.).

The Library Panel is where all of your graphics, 
symbols, imported pictures, sounds are stored 
and organized. An instance of these items can be 
dragged out of the library and onto the Stage. 

4. Timeline & Frames
The Timeline allows you to animate (moving, rotating, 
fading in and out, etc.) items over time based on the 
number of Frames per Second you’ve set your Stage 
to handle. The playhead will move across the timeline.

Frames are the “locations” on the Timeline you place 
your graphics, text, and symbols. Frames allow you to 
animate graphics, text, and sounds over time.

5. Layers
Allow you to separate out individual 
components, symbols and graphics on the 
Stage. If you want a background image to be 
behind another graphic create two layers and 
put the background graphic onto a Frame on 
the lowest layer.

Delete Layer/Folder
New Folder
New Layer

Playhead

3 Important
Stage 
Properties:
FPS: frames per 
second. Controls 
the animation 
speed.
Size: width and 
height.
Color: 
background 
color.
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Saving, Previewing, and Publishing a Flash file
Saving:

File menu -> Save As... name the file, a location, and click Save
Saving a file with a .FLA extension becomes your Flash project file. 
This file contains all of your layers, library graphics, symbols and 
other items, and animation/timeline effects you’ve created. You will 
use this file in Adobe Flash to make changes to the project. This 
file isn’t necessary when uploading to a web site or distributing 
your project to an audience... it is only for your use as your original 
project file.

Saving a file with a .XFL extention will organize all of your library 
items (photos, graphics, sounds, video, etc.) into a Library folder 
on your computer. That way you can organize all of your Flash file 
material and share it with another Flash Developer so they can 
work on your file. 

Preview (Test a Movie):
Control Key and Enter Key (Control menu -> Test Movie -> Test)
 Testing a Movie will create a file with a .SWF extension in the 
same location as your .FLA file is saved. This file is the final project 
file which will playback and show your Stage/animation. Your 
.SWF file will playback in the Flash plug-in inside a web browser (if 
you have inserted/embedded it into a web page) or it will playback 
in the stand-alone Flash Player (which comes with Adobe Flash).

Publish:
File -> Publish Settings
Publish Settings will allow you to control which types of files and 
settings are published when you go to finally publish out your Flash 
project. Options include publishing to HTML (a web page), Image 
types, and/or Projector Files (Flash projects packaged with the Flash 
Player) which creates an executable file a user double clicks.

File -> Publish Preview
Publish Preview will give you a preview of how your file will look 
when it is published to the settings you set in Publish Settings.

File -> Publish
Publish will save out the file(s) with the setting you have chosen in 
the Publish Settings.

2 Important Flash 
File Types:
1. .FLA 
Project file you use in 
Adobe Flash with all of the 
layers, timeline animations, 
and library items. FLA icon 
is shown below:

2. .SWF
Final animation file that 
plays back in the Flash 
Player or Flash Plug-in (in 
a web browser). Adobe 
Flash comes with a stand-
alone Flash Player but you 
must download the Flash 
Browser Plug-in at 
http://www.adobe.com.
SWF icon shown below:

Adobe Flash Player
Check Flash Version: http://www.adobe.com/flash/about
Download Flash Plug-in:  http://get.adobe.com/flashplayer/
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Graphics
Drawing tools, strokes and fills

Flash contains many tools used to draw basic shapes. 
In the tools panel you will find a pen tool, line tool, pencil 
tool, and brush tool. With these tools can you can move 
beyond the basic shapes and draw your own graphics.

Creating and editing shapes
There are other drawing tools included as well.
The Rectangle Tool (and other tools under that menu) allow 
you to draw basic shapes that can then be combined to 
form more complex drawings.

These shapes can contain a fill color (or gradient) and/or a 
stroke (line around the fill). The Swatches Panel (shown at 
right) shows many of the colors you can choose from for 
fills and strokes.

Shapes can be edited by using the Free Transform tool. 
This tool allows you to grab a handle and resize, reshape 
and rotate the object you have selected. First select the 
whole shape you want to transform by double clicking 
on the shape with the Selection tool (dark arrow). This 
will select both the stroke and fill of the shape. Then 
choose the Free Transform tool and resize or rotate your 
shape. While you resize or rotate in Flash CS5 you will 
see a “ghosted” version of the original shape so you can 
compare the original to the new resized/rotated shape.

If you have a specific sizing or rotation you want to apply to 
your shape then you can use the Transform Panel (shown 
at right). With a shape selected you can type in a new 
value for width and height and/or rotation values to make 
exact changes to these values. 

You can also use the Subselection Tool (white arrow) to 
grab single points on the stroke of a shape. Using this 
tool and selecting a stroke will show you a green thin line 
around a shape. The Subselection tool allows you to select 
a single point (or multiple points holding down the shift key 
while selecting your points) and dragging that point(s) to a 
new location.

free transform tool

subselection tool

selection tool
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Graphics
Drawing modes

In Flash there are 3 drawing modes to work in:
Merge Mode- use this mode to create unique shapes by combining 
and erasing into shapes. This Merge Mode is the default mode of 
drawing in Flash.

Object Mode- use this mode where you want the shape to be 
considered a single object which won’t combine or erase using 
other shapes. To make an Object Drawing choose the drawing tool 
you wish to draw with and click on the Object Drawing Icon (box 
with a circle inside).

Primitive Mode- allows you to modify the corner radius of a 
rectangle or oval shape in the properties panel after the shape has 
been drawn using the rectangle or oval primitive drawing tool.

Gradient and bitmap fills
Gradient colors can be used to fill a shape. Near the Properties 
Panel you will see a small painters pallete icon. If you click that icon 
the Colors Panel will open (show at right). From here you can drop 
down the menu that says “Solid color” and instead choose a linear 
gradient, radial gradient, or bitmap fill.

Linear Gradients are straight lines of color changes where as Radial 
Gradients look more like a circle or ball shape.

A Bitmap fill is a special type of fill where you choose a graphic/
image stored on your computer to serve as the fill item. For 
instance, if you have a photo of sky/clouds you could use that photo 
as a fill on a shape in Flash. Bitmap fills are usually used to add 
realism to a filled in shape.

Patterns and the deco tool
In Flash you can make custom Patterns to “paint” with. Flash 
also includes many brushes to draw with a tool called the Deco 
Tool. This deco tool will fill a shape (or the Stage) with a repeating 
decorative pattern or you can create some interesting animated 
effects using the Fire or Smoke Animations. 

deco tool

object drawing
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Graphics
Align, break apart, & group

Aligning objects on the stage can be done easily with the Align Panel. 
To align to objects select both with the Selection tool (dark arrow) by 
dragging the mouse in an area around both shapes. With both objects 
selected open the Align Panel and choose how you want to align the 
objects (top, middle, left, right, bottom alignment). You can also align 
an object (or multiple objects) to the Stage. 

Break apart allows you to disconnect aspects of an object. Objects 
that typically broken apart are text you’ve entered and want to 
animate individual letters/characters or Object drawings that you drew 
and want to modify as merge mode shapes. To Break apart an item 
select the item and press Control and B (or go to the Modify menu 
and Break apart).

Group objects/items allow you to temporarily combine two or more 
items together and move them around on the screen as if they are one 
item. To Group items together select the items and press Control and 
G on the keyboard (or go to the Modify menu and Group). Ungroup 
items by selecting that group and pressing Shift, Control and G.

Curves
Curves can be drawn/edited in a few different ways. The Pen Tool 
allows you to draw very specific curves. After drawing an object you 
can also use the Selection Tool (dark arrow) and hover over a stroke 
around a shape. Clicking down on the stroke and dragging will create 
a curved shape (shown at right).

Transparency
Colors of shapes you draw can take on a transparency allowing you 
to see through shapes and graphics. In Flash transparency is referred 
to as the Alpha level. 100% Alpha is completely opaque (filled in solid). 
Any level set under 100% will show a transparency through the object.

Text
Text can be added to the Stage in Flash just like typing text into 
any text editing program. Choose the Text Tool and determine the 
size, color, typeface, and other properties of the text using the 
Properties Panel. Then click the mouse on the Stage and type text. 
A new feature of Flash CS5 is a change to TLF text. TLF (text layout 
framework) text allows you to control more aspects of the text and 
create layouts similar to paragraph settings in Adobe InDesign. Or you 
can choose Classic text to control the traditional text 
functions in Flash. text toolT

selection tool
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Symbols
Import artwork

File menu -> Import -> Import to Stage (or Import to 
Library)
Flash allows you to import a wide variety of files into your 
Library or directly onto the Stage for use in your Flash 
projects. Examples include JPG photographs, MP3 sound 
files, drawings created in Adobe Illustrator and more. If 
you choose to import to library those assets can then be 
dragged and dropped onto the Stage. Depending on the 
type of file you choose you may be presented with a variety 
of importing options.

Create a symbol and symbol types
There are three types of symbols that can be created in 
Flash: Movie Clips, Buttons, and Graphics. To convert a 
shape to a symbol you select the shape with the Selection 
tool (dark arrow) and press F8 (Modify menu -> Convert 
to Symbol). You will see a Convert to Symbol box display 
with a drop down menu for the three symbol types. 
Choose the type you want and give that symbol a name. 
Then click OK. Your symbol will appear in the library and 
can be dragged to the stage to create an instance.

Movie Clip: these symbols have their own timeline and can 
contain their own separate animation.
Button: these symbols are used to create user interaction. 
Buttons can be scripted to control aspects of your Flash 
project at playback using ActionScript. 
Graphic: these symbols are similar to Movie Clips but they 
cannot be referenced by ActionScript (making them much 
less useful) because they can’t be given a name.

Managing symbols in the library
Managing your assets in the Library will make it easier to 
find and edit symbols. You can create folders to make it 
easier to find your different types of library assets. 

Symbol Type Naming Convention Example
MovieClip  mcSymbolName  mcAircraft
Button   btnButtonName  btnPlay

Instance Type Naming Convention Example
MovieClip  instanceName_mc  aircraft_mc
Button   instanceName_btn  play_btn

new folder
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Symbols
Editing symbols and sizing

You can edit a symbol on the Stage or in the Library 
by double clicking  on the image (either on Stage or 
Library). You’ll be in the image editing mode where you 
can edit size, shape, color, thickness of the stroke and 
more. Any edits made to the symbol will be changed in 
the library and any instances of that symbol you have 
on the Stage. 

In the image editing mode changes can be made after 
selecting the symbol and making appropriate changes 
in the Properties Panel or by using the Free Transform 
tool.

Symbol properties
Symbols contain their own Color Effects in the 
properties panel. The effects include Brightness, Tint, 
Advanced and Alpha (transparency).

Symbols also can take on Blending Options and 
Filters. Blending options allow you to control how 
your symbol looks when positioned over other 
objects on the Stage. Options include adding Hard 
Light, Darkening, Inverting Colors and more.These 
Blending Options work in the same way as in Adobe 
Photoshop.

Filters are especially useful in creating a more 
professional look right within Flash for your graphics. 
Filters in Flash include Drop Shadows, Blurred edges, 
Beveling, Gradient Glows and more. 

3D space
One of the last major developments in Adobe Flash 
is the addition of a 3D Rotation Tool and 3D Rotation 
properties in the Transform Panel (this was added 
in Flash CS4). This tool and panel attribute can be 
changed to allow for rotation of a symbol in 3D space. 
Objects in Flash are still 2D symbols but within Flash 
their appearance can be rotated in 3D space.

free transform tool
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Animation
Position, scale, rotation

Shape Tweening can help you acheive a few basic styles of animations 
on your drawings in Flash. Setting a shape in an initial state on a 
beginning keyframe you can then copy that shape (or draw an entirely 
new shape) onto a new keyframe and change several properties of 
that shape. Changing the position on the stage, the scale of a shape 
(size), and the rotation of a shape are all shape properties that can 
be animated (either individually or you can change any or all of these 
aspects in one shape tween animation). Shapes can also have the 
transparency (alpha level) of the stroke and/or fill color tweened to 
produce fade in and fade out effects across the timeline.
Symbols can be animated using Class Tween or Motion Tween. 
Classic is the traditional symbol animation whereas Motion Tweening 
is a more recent addition to Flash adding more control over symbol 
animation with the addition of an automaticaly generated motion guide 
and the addition of the Motion Editor Panel.

Pacing & timing animation
Frames per second can be used to control the speed of the 
animation. Typically the human eye sees about 24 - 30 frames per 
second as a smooth motion/animation (in video production you 
typically work at 29.97 frames per second). Also you can add more or 
fewer frames between keyframes and this will increase the time (slow 
your animation) or decrease the time (speeding up your animation). 
Simply click on the timeline in between keyframes on a layer you 
have a shape, classic or motion tween set up and click on the F5 
key (add frames keystroke). The F5 key will add one additional frame 
lengthening the animation (slowing it down) each time you hit F5. To 
remove frames you press Shift F5 with a frame selected between two 
tweened keyframes and you can remove frames (speeding up an 
animation). You can also click the mouse down on a keyframe and 
move it along the timeline to increase or decrease the pacing.

Animate transparency (and other color effects)
Transparency animation can be used to produce fade in/fade out 
effects on your shapes and symbols. If you are animating a symbol 
then choose the first keyframe and in the Properties Panel under Color 
Effect drop the Style menu down (shown at right) and select Alpha. If 
you are animating a fade in lower the initial alpha level down to 0%. 
The last keyframe can then be set to 100% alpha and your classic or 
motion tween will display a fade in effect from completely transparent 
to fully opaque. You can also animate the other color effects.

Motion 
Tween

Classic
Tween

Shape
Tween

End Blank
Keyframe

End Keyframe

Blank Frame

Blank Keyframe (F7)

Keyframe (F6)

Frame (F5)
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Animation
Path of motion

1. Guides: When you create a Classic Tween you can draw a guide 
path for that animation to follow along on a new Layer. Using any of 
the tools which draw a stroke (rectangle tool, oval tool, brush, pen 
tool, and the pencil tool) you can create a guide path (straight lines, 
curved arcs, zigzags, or any shape). Right click on that layer and 
convert it to a Guide. Then take the Classic Tween layer and using 
the mouse click and drag it up slightly to the Guide Layer to that 
the Classic Tween layer indents just under the Guide Layer. This will 
associate the Guide with the Classic Tween. Snap your beginning 
keyframe symbol to one end of your guide path and snap the ending 
keyframe to the other end of your guide path. Your Classic Tween will 
follow along the guide path when animating.

2. Motion Guides: When you create a Motion Tween you will 
automatically be given a Motion Guide on which you can 
animate your symbol. The Motion Guide can be shaped using 
the Selection Tool (dark arrow) and curving the guide to create 
an arc path along which the animation will occur. You can also 
use the Subselection tool (white arrow) to click on the end 
points of your motion guide path and adjust the amount of arc to the 
path. The entire Motion Tween can be easily moved to a new location 
on the Stage by using the Selection Tool (dark arrow) and drag and 
dropping the Motion Path to a new Stage location.

Symbol animation
Symbol animation is done using the Classic Tween or Motion Tween. 
Your Movie Clip or Graphic Symbol contains it’s own timeline which 
functions independently of the main Flash timeline. Inside your Movie 
Clip or Graphic the shapes drawn can have a shape tween applied 
to it which runs independently of the main timeline. This is used to 
incorporate shape tweening and motion tweening at the same time. 
For instance if you have a rocket ship graphic symbol you want to 
animate in an arc across the screen from left to right but also want 
that rocket symbol to have a shape tween of fire coming out of the 
back of the rocket you can “nest” a shape tween animation of the fire 
inside of a graphic symbol which has a motion tween to make the 
rocket go across the stage. When nesting animations keep in mind 
how many frames the “child” animation occurs over compared to 
the “parent” animation. If these don’t sync up you may end up with 
unusual results.
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Animation
Easing

Using Easing you can control the speed at which the animation 
moves. Easing In an animation speeds up the animation as it 
approaches the end keyframe. Easing Out slows an animation down 
as it moves toward the end keyframe.
Easing In: Accelerates towards the end keyframe (think of a car 
accelerating away from a stop sign gradually building up speed).
Easing Out: Decelerates towards the end keyframe (think of a car 
slowing down approaching a stop sign. The car gradually slows to a 
complete stop).

Shape Tween animation has a basic Easing applied to it by using the 
Properties Panel shown at upper right. Type in a number (-100 to 0 to 
100) to assign a level of easing to the animation.

Classic Tween animation has the same basic Easing option in the 
Property Panel but gives you a bit more control over the exact Easing 
of the animation when you click on the Edit Easing button (looks like 
a pencil off to the right of the Ease value). This Custom Easing dialog 
box allows you to change the slope of this graph chart to modify the 
easing to your own personal choice. 

Motion Tween animation has even greater control using the 
Motion Editor Panel. This panel shows you exactly which 
property you are animating by how much value and even allows 
for easing to be added to that animation. 

3D space animation
Another property you can animate in Flash CS5 is the 3D 
transformation property. Symbols can be animated by changing the 
ending or starting keyframes 3D Rotation allowing you to create 3 
Dimensional looking animation.

edit easing


